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Excel Tips & Tricks 

Dear fellow Excel enthusiast, 

If you’re not an enthusiast yet, I hope that with the help of these Tips & Tricks you soon 

will be.  

These are some of my favourite tips and power features that’ll get you well on your way to 

‘Excel Guru Status’ giving you not only the recognition you deserve, but also making your 

work more enjoyable. 

Kind regards, 

Mynda Treacy 
Microsoft MVP 

Co-founder 

My Online Training Hub 

 

 

 

 

 

SHARE THE KNOWLEDGE 

You have permission to share this e-book via email, by printing or even posting it on your 

website, Facebook account, Twitter or LinkedIn etc.  

The only conditions are: 

1. You don’t charge anyone money for it. That’s my right. 

2. You don’t change, edit, or alter the digital format or contents.  

3. All links must remain in place. 

My hope for this e-book is that you please share it with as many people as possible. And by sharing 

the knowledge many more people will love Excel and love their work. 

 

 

© Copyright 2023 MyOnlineTrainingHub.com 

https://www.myonlinetraininghub.com/
https://www.myonlinetraininghub.com/
https://www.myonlinetraininghub.com/
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Questions & Support 

Questions – If you have any questions or feedback, please contact me 

at: website@myonlinetraininghub.com  

 

Excel Support – Post your questions, screenshots and example Excel 

files on our Excel Forum where we’d be happy to help: 

https://www.MyOnlineTrainingHub.com/excel-forum  

 

Learn More - You can find more Microsoft Office training (including 

Excel, Word and Outlook video tutorials) and resources at 

https://www.MyOnlineTrainingHub.com  

Tip: Click menu to jump to section 

https://www.myonlinetraininghub.com/
mailto:website@myonlinetraininghub.com
https://www.myonlinetraininghub.com/excel-forum
https://www.myonlinetraininghub.com/
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Keyboard Shortcuts 

1.  
 

 

Inserts a SUM formula referencing the 
adjacent cells. 

2.  

 

 Switches between open Excel windows. 

3.  

 

Selects the entire worksheet. If the worksheet 
contains data, CTRL+A selects the current 
region. Pressing CTRL+A a second time selects 
the current region and its summary rows. 
Pressing CTRL+A a third time selects the 
entire worksheet. 

4.  

 

Displays the Format Cells dialog box or formatting 
panes for objects. 

5.  

 

Copies the cell above the active cell into the 
cell. Also copies objects (images, shapes, 
charts etc.) 

6.  

 

Copies a formula from the cell above the 
active cell into the cell or the Formula Bar. 

7.  

 

Repeats an action, or if you’re editing a cell and 
the cursor is in between the cell references it will 
insert the $ signs for absolute references. 
Repeated pressing F4 will scroll through different 
levels of absolute references. 

8.  

 

Uses the Undo command to reverse the last 
command or to delete the last entry that you 
typed. 

9.  

 

Opens the Hyperlink dialog box. Also works in 
Word, Outlook, PowerPoint and more! 

10.  

 

Opens the Find dialog box. 

11.  

 

Opens the Find & Replace dialog box. 

12.  

 

Opens a new workbook. 

https://www.myonlinetraininghub.com/
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13.  

 

Displays the Open dialog box to open or find a 
file. 

14.  

 

Edits the active cell and positions the 
insertion point at the end of the cell contents. 
It also moves the insertion point into the 
Formula Bar when editing in a cell is turned 
off. 

15.  

  

Runs Spell Check on the entire worksheet if 
only one cell is selected, otherwise Spell 
Checks the selected range. 

16.  

  

Inserts named ranges for an entire table 
automatically based on the column or row 
headings (your choice). 

17.  

 

Opens the File Save As dialog box. 

18.  

 

Saves workbook. 

19.  

 

Copy 

20.  

 

Cut 

21.  

 

Paste 

22.  

 

Pastes Values (365 and versions later than 
2021 only) 

23.  

 

 

Move to end of a range of cells (column or 
row). Your selected cell will stop at any empty 
cell in the range, or if cells are empty it will 
stop at the next populated cell in the column 
or row. Bonus tip: Also hold SHIFT to select 
cells. 

24.  

  

Quickly move to home. If you have frozen 
panes your cursor will stop at the intersection 
of the frozen panes. 

https://www.myonlinetraininghub.com/
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25.  

 or 

 

Move between worksheets 

26.  

  

View formulas instead of values 

27.  

 

Inserts today’s date. Bonus tip: also hold 
SHIFT to enter the current time. 

28.  

 

Opens the emoji palette (in all apps)         

29.  

 

Opens the right mouse button menu. 

 

 

 

 

Want more keyboard shortcuts?  
Keyboard shortcuts help you work faster. Download our 239 Excel Keyboard 

Shortcuts e-book here. 

  

https://www.myonlinetraininghub.com/
https://www.myonlinetraininghub.com/excel-shortcuts
https://www.myonlinetraininghub.com/excel-shortcuts
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Tips & Tricks 

30. Hidden Double Click Shortcuts – it’s not all about the keyboard. The mouse also has some 

super handy shortcuts available. Check them out here. 

 

31. Transpose Data Copy data > Paste Special > Transpose.  

 

32. Increase Numbers by Set Amount – Enter the figure you want to increase numbers by, say 

10%, you’d enter 1.1. Copy the cell containing 1.1 > highlight the cells containing the numbers 

you want to increase > Paste Special > Multiply: 

 

 
 

Bonus tip: convert negative values to positive by multiplying by -1 and vice versa. 

 

  

https://www.myonlinetraininghub.com/
https://www.myonlinetraininghub.com/hidden-excel-double-click-shortcuts
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33. AutoFill a Series or Formulas – Double Click on the + symbol on the bottom right of a cell that 

is adjacent to the range you want to fill.  

 

Before                        After 

                     
 

34. Flash Fill – Use built in AI to split, join, clean text and dates. Give flash fill one or more 

examples, then select the range and press CTRL+E to flash fill the rest: 

 

35. Force a carriage return in a cell instead of wrapping the text – while editing the cell, press:

 
 

36. Use Format Painter more than once – Double Click the Format 

Painter and use it as many times as you like. When you’re done 

press ESC.  

 

  

https://www.myonlinetraininghub.com/
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37. Format Sheet Tab Colours – Right-Click mouse on Sheet Tab > Tab Colour. 

 

 
 

38. Combine Text from Multiple Cells – Enter your formula with the ampersand ‘&’ between the 

cell references e.g. =A1&A2&A3 will add the text in cell A1, A2 and A3 together.  

Bonus tip: Excel 2019 onward and 365 users can use the TEXTJOIN function to join text with a 

delimiter and ignore empty spaces. More on the TEXTJOIN function here. 

 

39. Delete blank cells in a row or column – 

Highlight the column or row containing cells 

you want to delete. Press CTRL+G to open the 

Go To Dialog Box > Special > Blanks.  

Delete cells, rows or columns. 

 

40. Fill blank cells in a row or column - Highlight 

the column or row containing cells you want to 

fill. Press CTRL+G to open the Go To Dialog Box 

> Special > Blanks.  Enter the text or formula 

you want to insert > press CTRL+ENTER to 

enter the text/formula in every blank cell. 

 

41. Copy & Paste visible cells only – In a filtered 

list of data copy the list > Paste Special > Skip 

Blanks. Or if your list isn’t filtered use Go To 

Special to select visible cells only: CTRL+G > Special > Visible Cells Only > Paste. 

 

  

https://www.myonlinetraininghub.com/
https://www.myonlinetraininghub.com/excel-textjoin-function
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42. Insert custom cell formats: 

Custom Cell Formats Text Before 
Formatting 

Custom Format Formatted Text 

Brackets for negative 
values 

-500 #,##0;(#,##0) (500) 

Red and brackets for 
negative values 

-500 #,##0.00;[Red](#,##0.00) (500.00) 

Day of the week in full 27/03/2010 dddd Saturday 

Day, date, month and year 27/03/2010 ddd dd mmm yyyy Sat 27 Mar 2010 

Month 27/03/2010 mmmm March 

Phone Numbers 755551234 00 0000 0000 07 5555 1234 

Phone Numbers with 
Brackets 

755551234 (00) 0000 0000 (07) 5555 1234 

Fractions 10.5 # ??/?? 10  1/2 

Trailing Characters Date: @*_ Date:_______________ 

Leading Characters Page 1 *.@ …………………….Page 1 
 

Click here for more custom cell formats tips and tricks. 

 

43. Use Named Ranges in your formulas to make them easier to build and read when you come 

back to your workbook weeks or months later. Click here for the Named Range tutorial. 

  

44. Apply different formats within one cell – it could be different fonts, font colours, styles etc. 

Select the cell you want to format > F2 to edit the cell > highlight the text you want to change > 

Use the formatting tools on the Home tab of the ribbon. 

 

 

  

https://www.myonlinetraininghub.com/
https://www.myonlinetraininghub.com/excel-custom-cell-formats
https://www.myonlinetraininghub.com/excel-named-ranges-explained
https://www.myonlinetraininghub.com/excel-named-ranges-explained
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Move, insert and copy columns, rows and cells using the Mouse + SHIFT or CTRL.  

45. Move column, row or cells: Select the range of cells, column(s) or row(s)  > hover your mouse 

over the edge of your selected range of cells (or columns or rows) >when the mouse pointer 

changes to a 4 pointed arrow left click the mouse and hold down while you drag your cells 

to a new location. 

46. Move and insert column, row or cells: As above except also hold down the SHIFT key while 

hovering your mouse over the edge of the selected area. Then drag the cells (while holding 

down the SHIFT key) and insert then in a new location. 

47. Copy and paste a column, row or cells: As above except hold down the CTRL key while 

hovering your mouse over the edge of the selected area. Then drag the cells (while holding 

down the CTRL key) and release the mouse where you want to paste the data. 

48. Copy and insert a column, row or cells: As above except hold down the CTRL+SHIFT keys while 

hovering your mouse over the edge of the selected area. Then drag the cells (while holding 

down the CTRL+SHIFT keys) and release the mouse where you want to insert your data. 

 

  Mouse Pointer in 45 and 46               Mouse Pointer in 47 and 48 

                        
Note: these mouse pointers may appear different on your PC if you have a different 

operating system or have customised how your mouse appears. Not to worry, the shortcuts 

above will still work as described. 

 

  

https://www.myonlinetraininghub.com/
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49. Copy formulas only - Copy cell 

containing formula you want to copy > 

Paste Special > Paste Formulas.  

 

 

50. Quickly enter links to a range of cells – 

Copy cells you want to link to > Paste 

Special > Paste Links. 

 

    

 

 

 

51. Freeze rows and or columns at the top 

or left of your workbook so that headings 

stay in place while you scroll down the 

worksheet. Place your cursor at the 

intersection of the rows/columns you want 

fixed in place i.e. Frozen. Go to View tab of 

the ribbon > Freeze Panes: 

 

 

 

 

 

52. Synchronous Scrolling – want to 

compare two workbooks and have 

them both scroll at the same time?  

With two workbooks open View tab 

of the ribbon > View side by side > 

Synchronous Scrolling: 

  

https://www.myonlinetraininghub.com/
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Want to tamper-proof your workbook?  

53. Hide worksheet tabs > Windows Button > Excel Options > Advanced > Display Options > 

uncheck ‘Show sheet tabs’. 

 

54. Hide row and column headers > Windows Button > Excel Options > Advanced > Display 

Options for this workbook > uncheck ‘Show row and column headers’ or View tab of the 

ribbon > uncheck ‘Headings’ in the Show/Hide group. 

 

55. Hide the formula bar > View tab of the ribbon > uncheck ‘Formula Bar’ in the Show/Hide 

group. 

 

Click here for more on workbook protection. 

 

 

56. Add non-contiguous print areas – Set first print 

area, then select second print area and on the 

Page Layout tab of the ribbon select ‘Add to print 

area’.  Each print range will print on a separate 

page.  

 

 

 

57. Pick from a list of existing values – in the cell 

under your data hold down ALT + Down Arrow - 

Excel will give you a list of values to choose from. 

Use the arrow keys to select the one you want, and 

press ENTER to insert it.  

 

 

 

  

https://www.myonlinetraininghub.com/
https://www.myonlinetraininghub.com/excel-workbook-protection
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58. Print titles on each page automatically – On the Page Layout tab of the ribbon select Print 

Titles. This will open the Page Setup dialog box. Enter your rows and/or columns you want 

repeated in the boxes highlighted below by clicking in the box and then clicking on the row or 

column header on your worksheet. 

 

 
 

 

 

 

  

https://www.myonlinetraininghub.com/
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Before pressing ALT + = 

After pressing ALT + = 

59. Quickly SUM a range of cells – select entire table (or it could be just a row or column of 

values) plus the blank cells you want your SUM formula in, then press the ALT + = keys. 

 

 

 
 

 

 

 
 

 

60. Generate a unique list of values from 

a range – Select the range > Data > 

Filter > Advanced Filter > Unique 

Records Only.  

 

Note: select if you want to copy it to a 

new location or replace the existing 

data by selecting ‘Copy to another 

location’ and then inserting the ‘Copy 

to’ cell reference.  

 

 

 

 

 

 

 

 

These are the blank cells 

where the SUM formula 

will be inserted. 

Formulas that were 

inserted. 

https://www.myonlinetraininghub.com/
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61. Use the AutoCalculate Menu in the bottom right of your Excel window to get a quick sum, 

average, or count. Right click on the area to add Min, Max and more. Select the range of cells 

you want to sum/average/count. Tip: Hold down CTRL to select non-contiguous ranges. 

 
 

62. You don’t have to start your formulas with =  If you’re a fan of the number keypad and arrow 

keys then it’s sometimes inconvenient to move your hand across to the = symbol every time 

you want to enter a formula. If you start a formula with + or – Excel will put the = sign in for 

you when you press ENTER. After pressing ENTER your formula will look like this =+A1+A2 or =-

A1+A2 which is perfectly fine. 

 

 

63. Center Across Selection – Instead of Merging 

Cells, which puts limits on inserting and deleted 

columns and rows among other things, simply 

format the cells alignment to ‘Center across 

selection’. CTRL+1 to open Format Cells dialog 

box > Alignment tab > Horizontal Text Alignment 

set to ‘Center across selection’. 

 

 

64. Find the number of days between two dates – Reference two cells containing dates or enter 

your dates inside double quotes e.g. ="20/6/2011"-"28/10/2006"  Result = 1696 

 

65. Move quickly to the end of a range of cells – select a cell in the range > move your mouse to the edge 

of the cell until your mouse pointer changes to a 4 headed arrow > double click. You can do this on any 

edge of the cell to move in the direction of your choice. 

 

66. Fill Handle Cool Tricks – Most of us know that you can left-click 

the mouse and drag the fill handle to fill a series (the fill handle is 

when your mouse pointer changes to a + symbol when hovered 

over the bottom right of the cell range – see image), but have you 

tried right-clicking the mouse while you drag the fill handle? 

There are myriad choices when you do this, so have a go and 

experiment.   

https://www.myonlinetraininghub.com/
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Must Know Functions and Formulas 

Click the links to read the full tutorial for each function/formula. 

67. Pro Excel Formula Writing Tips - Formulas are THE MOST IMPORTANT EXCEL SKILL you can 

master, but when you start nesting functions, things can quickly get out of hand. Click here to 

learn some little known Excel formula writing tips, tricks and tools that’ll give you ninja level 

skills and enable you to decipher any formula. Even ones you haven’t written yourself.  

 

68. Absolute References – Understanding Absolute References is essential to working with 

formulas in Excel. Remember: use the F4 tip in the keyboard shortcuts when working with 

absolute references. Click here to learn the ins and outs of Absolute References. 

 

69. 5 SUM Function Tricks – The SUM function is usually one of the first functions new Excel users 

learn, but most are never aware of these 5 tricks up its sleeve. Click here to learn more. 

 

70. IF, IFS and Nested IFs – Learning how to write an IF statements increases the power and 

functionality of Excel tenfold. Learn all 3 options here. 

 

71. IF, OR and AND used together – know these and you’re unstoppable! Click here to take your IF 

formulas to the next level. 

 

72. XLOOKUP replaces VLOOKUP, HLOOKUP, INDEX & MATCH and LOOKUP functions in one go 

and isn’t error prone like the others. Learn everything there is to know about XLOOKUP here. 

 

73. SUMIF and SUMIFS – Like the IF statement but for SUM. Excel also has AVERAGEIF and 

AVERAGEIFS which work the same as the SUM only they Average. Master the SUMIF and 

SUMIFS functions here. 

 

74. COUNTIF and COUNTIFS – similar to SUMIF only since it’s only counting it’s slightly easier, but 

no less powerful. Learn COUNTIF and COUNTIFS here. 

 

75. COUNTA – COUNT counts number values, but if you want to count text use COUNTA. 

 

76. AGGREGATE – the new improved SUBTOTAL function. I call it the Swiss Army Knife of functions 

because it can sum, average, min, max, count and 15 more as well as skip errors, hidden rows 

etc. Master the AGGREGATE function the need for 19 functions in one go.  

 

77. ROUND, ROUNDUP, ROUNDDOWN – Before long you’ll need to round your numbers with 

more accuracy than simply formatting the font. Get to grips with rounding in this tutorial. 

https://www.myonlinetraininghub.com/
https://www.myonlinetraininghub.com/pro-excel-formula-writing-tips
https://www.myonlinetraininghub.com/excel-absolute-references-the-missing-link
https://www.myonlinetraininghub.com/5-excel-sum-function-tricks
https://www.myonlinetraininghub.com/excel-ifs-function
https://www.myonlinetraininghub.com/excel-if-and-or-functions-explained
https://www.myonlinetraininghub.com/excel-if-and-or-functions-explained
https://www.myonlinetraininghub.com/excel-xlookup-function
https://www.myonlinetraininghub.com/excel-sumif-and-sumifs-formulas-explained
https://www.myonlinetraininghub.com/excel-sumif-and-sumifs-formulas-explained
https://www.myonlinetraininghub.com/excel-countif-and-countifs-formulas-explained
https://www.myonlinetraininghub.com/excel-count-counta-and-countblank-functions
https://www.myonlinetraininghub.com/excel-aggregate-function
https://www.myonlinetraininghub.com/how-to-round-numbers-in-excel-using-round-formulas
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78. FV Calculate compound interest on savings – Want to save some money for a rainy day and 

curious to know what it’ll be worth? Click here to see how Excel can tell you. 

 

79. IFERROR - Once you start using some of the formulas above, you’re likely to have errors 

returned. If you’re expecting errors and want to hide them you can use the IFERROR formula. 

 

80. MIN, MAX, SMALL and LARGE – These may seem straight forward, but I’ll show you a few 

tricks that you won’t find in the Excel Help Files. Check them out here. 

 

81. UPPER, LOWER and PROPER – Fix text that isn’t formatted as you want. Change all CAPITALS 

to all Lower or make the first letter in each word a capital (PROPER). Bonus tip: if you prefer 

not to use a formula, you can use a font like Felix Titling that’s all caps instead! 

 

82. SEARCH, FIND, MID – extract data with this system for building formulas that split text. Click 

here for my 5 step system for extracting text strings. 

 

83. Time Calculations – Most people at some stage or another need to calculate time in Excel, but 

if you don’t understand how Excel treats time you’ll find it infuriating! Click here to see how 

Excel handles time under the hood. 

 

84. NOW() and TODAY() – simply type =NOW() in a cell and you will get the date and time as per 

your computer clock or =TODAY() will give you the date only. Handy for date/time stamping 

your printed reports. 

  

https://www.myonlinetraininghub.com/
https://www.myonlinetraininghub.com/how-to-calculate-interest-on-savings-in-excel
https://www.myonlinetraininghub.com/excel-iferror-puts-an-end-to-messy-workarounds
https://www.myonlinetraininghub.com/excel-min-max-small-and-large-functions
https://www.myonlinetraininghub.com/excel-upper-lower-and-proper-functions
https://www.myonlinetraininghub.com/excel-mid-function
https://www.myonlinetraininghub.com/excel-mid-function
https://www.myonlinetraininghub.com/calculating-time-in-excel
https://www.myonlinetraininghub.com/calculating-time-in-excel
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Power Formulas 

85. Dynamic Array Formulas – new for Office 2021 and 365 users and the future of Excel. Dynamic 

Arrays fundamentally change the Excel calc engine, therefore Excel users of all levels should 

master them. Click here to learn about Dynamic Arrays and the fun that awaits. 

 

86. INDEX – Most only know one way to use INDEX. In this tutorial I show you 5 INDEX function 

secrets that will prove that you’re a pro user. 

 

87. FILTER – The filter function is one of the new dynamic array functions. It solves problems that 

used to require super complex nested array formulas with ease. Learn FILTER here. 

 

88. UNIQUE – Another dynamic array function, UNIQUE can extract a list of distinct values, or a list 

of values that only occur once, i.e. unique values. It can return a unique or distinct list from 

one column or from multiple columns. It’s magical! Master the UNIQUE function here. 

 

89. VSTACK & HSTACK – These text manipulation functions are life changing enabling us to 

rearrange data into a single array as part of the dynamic array function library. Don’t miss out 

on these exciting new functions. Check out the VSTACK & HSTACK tutorial here.  

 

90. OFFSET – Tired of having to update your totals to incorporate new rows? This is one great 

feature of the OFFSET function, but it has many more uses including dynamic named ranges. 

Master OFFSET here. 

 

91. SORT & SORTBY – with these dynamic array functions we can now dynamically sort data with 

these easy to use functions. No more complex nested multi-cell array functions. See these 

functions in action here: SORT | SORTBY 

 

92. RAND, RANDBETWEEN and RANDARRAY – Generating random data is something I do 

regularly as I need to create data to support the tutorials I write, but you could also use it in 

your work to do the same, or team it with CHOOSE and use it to choose random values from a 

list. Click here for RAND and RANDBETWEEN examples and click here for RANDARRAY 

examples.  

 

93. IMAGE - The IMAGE function enables you to insert images into cells with a formula! From 

there you can resize them, sort, filter and more. It supports BMP, JPG/JPEG, GIF, TIFF, PNG, 

ICO, and WEBP file types. Check out the IMAGE function here. 

 

  

https://www.myonlinetraininghub.com/
https://www.myonlinetraininghub.com/excel-dynamic-arrays
https://www.myonlinetraininghub.com/5-excel-index-function-secrets
https://www.myonlinetraininghub.com/5-excel-index-function-secrets
https://www.myonlinetraininghub.com/excel-functions/excel-filter-function
https://www.myonlinetraininghub.com/excel-functions/excel-unique-function
https://www.myonlinetraininghub.com/excel-vstack-and-hstack-functions
https://www.myonlinetraininghub.com/excel-offset-function-explained
https://www.myonlinetraininghub.com/excel-sort-function
https://www.myonlinetraininghub.com/excel-sortby-function
https://www.myonlinetraininghub.com/excel-rand-and-randbetween-functions
https://www.myonlinetraininghub.com/excel-randarray-function
https://www.myonlinetraininghub.com/excel-randarray-function
https://www.myonlinetraininghub.com/excel-image-function


 

 

M y  O n l i n e  T r a i n i n g  H u b    h t t p s : / / w w w . M y O n l i n e T r a i n i n g H u b . c o m  
 

P a g e  2 0  

Cool Tools 

94. Automate the BORING tasks of getting and cleaning data with 

Power Query. Stories of automating tasks that used to take 3 hours now 

taking 3 minutes with Power Query is not uncommon or an exaggeration. 

Get up and running with my Introduction to Power Query video here. 

 

 

95. Excel Icons – the sophistication of professional icons, images and art can give your workbooks 

and reports a truly professional finish. Don’t be surprised if people think you got a graphic 

designer involved. Check out Excel’s icon sets here.  

 

96. Camera Tool – You won’t find any mention of the camera tool in a 

standard Excel course. After all you won’t even find it in the tool bar or 

ribbon. It’s handy if you only have one monitor and pine for two, or if 

you want to create dashboards with lots of small charts. See the 

Camera tool in action here. 

 

97. Conditional Formatting – Use Conditional Formatting 

to bring life to your drab data, make highlighting 

duplicates instant and much more. Master Conditional 

Formatting here. And if Conditional Formatting with 

formulas does your head in, watch this tutorial to see 

how it works under the hood. I promise everything 

will be easy once you know how it works. 

 

98. Drop Down Lists – or Data Validation as it’s formally called in Excel. If you build forms or 

reports for other’s to use, Data Validation can make them more interactive and reduce the 

chances of the wrong data being filled out. Click here to learn Data Validation ins and outs. 

 

99. Outlines – You can insert outlines that enable you to quickly hide and unhide 

rows and columns using the Group and Ungroup tools. I love using these 

instead of hiding columns and rows as it allows me to hide and unhide again 

at the click of only one button. Learn how to Group and Outline your data 

here. 
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100. Excel Tables – Formatting your data in a Table allows you to add to the content and have 

any formulas or pivot tables that reference the data automatically pick up the new cells.  

Tables are the secret to building reports fast and updating them in an instant, and 

only 2% of Excel users know about them! 

Plus, there’s a range of other benefits like great predefined formatting and more. Get up to 

speed with Excel Tables here. 

 

 
101. PivotTables – A lot of people are 

afraid of PivotTables, but they really are 

quite simple once you understand the 

basics. 

 

If you work with large amounts of data 

PivotTables can create dynamic reports 

in seconds from tens of thousands of 

rows.  

 

Get up to speed with my “PivotTables 

Made Easy” video where I also teach 

you why things go wrong, so you can 

avoid these common mistakes. Click 

here to watch the tutorial and 

download the practice Excel file. 

 

  

https://www.myonlinetraininghub.com/
https://www.myonlinetraininghub.com/excel-tables
https://www.myonlinetraininghub.com/excel-tables
https://www.myonlinetraininghub.com/excel-pivot-table-video-tutorial
https://www.myonlinetraininghub.com/excel-pivot-table-video-tutorial
https://www.myonlinetraininghub.com/excel-pivot-table-video-tutorial


 

 

M y  O n l i n e  T r a i n i n g  H u b    h t t p s : / / w w w . M y O n l i n e T r a i n i n g H u b . c o m  
 

P a g e  2 2  

Thank you for taking the time to read these Tips & Tricks. I snuck in an extra one and quite 

a few bonus tips along the way. Enjoy using your new Excel powers. Feel free to email me 

with feedback or ideas. 

Kind regards, 

Mynda Treacy 
Microsoft MVP 

Co-founder 

My Online Training Hub 

 

 

 

SHARE THE KNOWLEDGE 

 

Now that you’ve read the whole book, please forward it to your friends 

and colleagues and share the knowledge. Please just make sure you 

follow the conditions below. 

You have permission to share this e-book via email, by printing or even by 

posting it on your website, Facebook account, Twitter or LinkedIn etc.  

The only conditions are: 

1. You don’t charge anyone money for it. That’s my right. 

2. You don’t change, edit, or alter the digital format or contents.  

3. All links must remain in place. 

My hope for this e-book is that you please share it with as many people as 

possible. And by sharing the knowledge many more people will love Excel and 

love their work. 
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DID YOU LIKE THESE TIPS & TRICKS? 

WANT MORE? 

ONLINE TRAINING 
 
 
 
 
 

 

EXCEL NEWSLETTER  

Or sign up for our free online training and get instant access to over 

150 video tutorials on Excel, Word and Outlook. 

 

FOLLOW MY ONLINE TRAINING HUB 

 

       
 

 

QUESTIONS? 

Excel Support – Post your questions, screenshots and example Excel 

files on our Excel Forum where we’d be happy to help: 

https://www.MyOnlineTrainingHub.com/excel-forum  

If you have any questions or feedback please contact me at: 

https://www.myonlinetraininghub.com/contact-us  or 

website@myonlinetraininghub.com  
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